Google Docs Tipsheet

ABEL Summer Institute 2009

Contents
Logging in to Google Apps for CollaborativeSchools.net for the First Time ............... 2

Text Documents
Creating a New Text Document in Google Docs ............................................................. 5
Uploading a Document to Google Docs .......................................................................... 9
Sharing a Document...................................................................................................... 11
Collaborative Writing ..................................................................................................... 14
Creating a Template ...................................................................................................... 16

Presentations
Getting Started with Presentations ................................................................................ 18
Adding Images to Google Presentations ........................................................................ 19

Forms and Spreadsheets
Creating a Form to Collect Student Responses ............................................................ 21
Sharing the Survey with Students ................................................................................. 22
Viewing the Survey Results ........................................................................................... 23
Creating a Graph in Google Spreadsheets ................................................................... 24

Google Sites (Wikis)
Collaborating on Sites ................................................................................................... 26
Adding a Link on Your Site ............................................................................................ 27
Starting a Class Website Using Google Sites ............................................................... 29

Other
Firewalls ........................................................................................................................ 31

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
Logging in to Google Apps for CollaborativeSchools.net for the First Time

1) Go to http://tinyurl.com/abelgoogle
   a) You will automatically be redirected to the ABEL Summer Institute Homepage at https://www.google.com/a/collaborativeschools.net/abel/

2) Click on the Google Docs link on the left side of the page

3) You will be redirected to the Google Docs login screen for the CollaborativeSchools.net

4) Use the username and password provided to you to login.
   a) Username: _______________________________
   b) Password: ________________________________

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
5) You will come to the account setup page.

6) You will have to enter the characters in the CAPTCHA box (those distorted annoying letters used to tell you apart from computers).

   **TIP:** You can press [CTRL] & [+] to magnify your screen so you can see the letters in the CAPTCHA box more clearly and enter them in the text box. Then press [CTRL] & [-] to zoom back out.

7) Scroll down to the bottom of the screen and press I accept. Create my account.
8) You will be brought to the Google Docs homepage.

9) You can now create, edit and share documents, spreadsheets and presentations with anyone else who has an @collaborativeschools.net login.
Creating a New Text Document in Google Docs

1) Click on the New menu and then choose Document.

2) Your new document will open in a new tab.

3) Most of the menu headings and icons should be familiar to you.

4) Change the title of the document (and the name it is saved as, by clicking where it says "Untitled")
5) A new dialogue box will open asking you to “Enter new document name:” Name the document something like “My First Google Doc” and put your name after it.

6) Click OK

7) You can now enter text and create tables or drawings, just the same as you might in any other desktop text editor.

8) Play around with it for a while.

9) Notice that your work is automatically saved every couple of minutes.

10) If you prefer the “Page” view, go to the View menu and choose Fixed-width page view.

11) Other interesting and useful menus that you or your students may use frequently are the Insert and Format menus.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
12) The file menu also has many important options.

a) In particular, the Revision history shows all changes made to a document since its creation. This is particularly useful for groupwork if you want to see which students have contributed what work to a project or to get a sense of how much time a student has actually spent on a project.
b) **Download file as** allows you or the student to save work in a variety of formats including PDF.

13) The **Tools** menu allows students to spell check their work, complete a word count and look up words in a dictionary or thesaurus.
Uploading a Document to Google Docs

Note: To complete this exercise, you must have a document, presentation or spreadsheet that you can upload. You can do this using a file that you have on your own computer or by quickly creating a text document in Word, Power Point or Excel and saving it on the computer you are working on.

1) Click on the upload button.

2) Choose the file that you would like to upload from your computer (or memory stick).
   a) In this case you will choose a file that you already have, or one that you have created quickly.

Types of files that you can upload:
   a) Documents (up to 500KB)
      i) HTML files and plain text (.txt).
      ii) Microsoft Word (.doc, .docx), Rich Text (.rtf), OpenDocument Text (.odt) and StarOffice (.sxw).
   b) Presentations (up to 10MB from your computer, 2MB from the web, 500KB via email)
      i) Microsoft PowerPoint (.ppt, .pps).
   c) Spreadsheets (up to 1MB)
      i) Comma Separated Value (.csv).
      ii) Microsoft Excel (.xls, .xlsx) files and OpenDocument Spreadsheet (.ods).
   d) PDF Files (up to 10MB from your computer, 2MB from the web)

3) You can also add files from the web or send email to create text documents.
4) Click on Upload File.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
5) Your document will appear in a new window, ready for editing.
Sharing a Document

1) Start by opening the document that you created earlier (i.e. My First Google Doc)
2) Click on the Share button, and then click on Invite people . . .

3) The Share with others dialogue box will appear.

- Invite people
- People with access
- Advanced permissions

- Invite: (Any email address will work)
- abel32@collaborativeschools.net
- scott.monahan@collaborativeschools.net

- Subject:
- My First Google Doc - Scott

- Message:
- Hi,
  This is my first time sharing a Google Doc!

- Send a copy to myself
- Send
- Add without sending invitation

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
a) **Invite:** Type in the address of the person (or people) sitting beside you. Note that while it says that “Any email address will work”, the person must have a collaborativeschools.net account to actually view the document that you are sharing. So even if a student sends it to someone who isn’t in your class, they won’t be able to see the document. Try it by sending it to another email account of your own and checking it when you go home tonight!

b) **To Edit vs. To View**
Allowing collaborators to edit allows them to make changes to your document, presentation or spreadsheet. This is ideal for group work, or when a student shares their work with you, because they want you to be able to make comments or changes in their work. To view only allows the collaborator to see the document. This is ideal if you have something like a template that you want students to work on, but would like them each to save their own copy and share it back with you.

Tip: When students share work with you, have them put their first name in the title of the document, especially if the logins that you give them are a random series of numbers/letters. This helps to be able to tell which work belongs to which student, and also if you have 27 copies of Reading Response for Chapter 4.

c) **Subject** is the Subject line of the email that the collaborator will get when you share the document with them.

Note: Depending on the age of your students, your parent community, your principal, etc. you can turn off features of Google Apps such as Email and Chat. The students will not get an email, but the shared document will still show up in their list of documents.

d) **Message:** Any message that you want to go in the email possibly giving tips, page numbers, deadlines, etc.

e) **Send a copy to myself:** Always a good idea when you’re teaching!

f) **Add without sending invitation** will add collaborators to the document without sending them an email message.

g) **Send** will send a message inviting the collaborators to view the document.

4) Once you press **Send** or **Add without sending invitation**, you will be switched to the next tab in the **Share with others** dialogue box.
5) You can now see who the document is shared with.

Note, although you can change whether or not sign-in is required to see this document, for this document, this is only available because I’ve loosened the security for the ABEL Summer Institute session. On the version I use with my students, this option does not appear.

7) Click the **Save and Close** button.

8) Click **Save and Close** at the top right of your Google Docs page.

9) Check with your neighbour – do they have a copy of your shared document? Do you have a copy of the document they shared with you?
Collaborative Writing

1) Form a group of 2 – 5 people
   a) Note: Up to 10 people can edit a document at the same time
      Up to 50 people can edit a spreadsheet at the same time
      Up to 10 people can edit a presentation at the same time

2) Have one member of your group click on **Browse template gallery** at the top of the page.

   ![Browse template gallery]

3) Click on the **ABEL Summer Institute Templates** tab, and then the **Use this template** button under the Shared Writing template.

4) Share the document with all members of your group. Make sure they are all editors.
   See the tutorial on sharing documents or ask for help if you aren’t sure how to do this.

5) Your group members may have to refresh their Google Docs homepage to get your newly shared document to show up. (Alternatively, they could check their Collaborative Schools Gmail accounts for an invite to edit the document).

6) Take some time to work on the document. The idea here is that you will see how long it takes for a collaborators work to show up in the document you are working on. It should be between 30 seconds to one minute. You can certainly add any thoughts you would like to the document.

---

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
7) Add a comment to someone else’s work (just so you can try it out and see how you might use it with students)
   a) Go to the Insert menu and choose Comment

8) After a few minutes, check the revision history of the document. This is where you can see who has done what, and at what time.

9) To return to your document, click Back to editing.
Creating a Template

Creating a template is a great way to share “worksheets” or graphic organizers with students. You can only create templates from documents that you are the owner of and which are not shared with other collaborators. If you are not the owner of a document, save a new copy of the document and you will be the owner.

1) The document that you want to create a template from, must be stored in your Google Docs list already.

2) From the Google Docs homepage, click on the Template Gallery

3) At the top right, click on Submit a Template.

4) Click on Choose from your Google Docs

5) Select the document that you would like to create a template from.

Note: It may take a bit of time for recently created documents to appear here, but it does seem to work much quicker with uploaded documents and spreadsheets.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
6) Click on the file you want and then press Select. Note that you can narrow your search by clicking on the types of files on the left side of the box.

7) Enter a description that will give your students some background on what the template is for. Select a category(ies) and the language. Then click on Submit Template.

8) Within a couple of minutes it will be available in your list of templates.

9) To use the template, click on the Template Gallery link, and choose the template that you want to use.

10) Check out the APE Reading Response Template under ABEL Summer Institute Templates for one example of how you might use this in your classroom.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
Getting Started with Presentations

1) In the list of files that appear on your Google Docs homepage you will see a presentation file called Group (A, B, C, etc.) Presentation.

You DO NOT have to make a presentation!

Click on it to open it.

2) You have been grouped by your login with 3 other participants in this session. You can add more participants if you would like.

3) There are four slides in this presentation as it is now.
   a) Title Slide
   b) Ways to Use this in Our Class...
   c) I would like to...
   d) Questions I Still Have...

4) These are just set up for you to play with and explore the program. Like other presentation software, you can change the background, add pictures, copy and rearrange slides, etc.
Adding Images to Google Presentations

Obviously, it is your responsibility to teach your students about the kinds of images that they can use in their presentations. Using images they've created with a camera, with a graphics program, or by scanning their own work is easy, but teaching them the proper way to use other peoples work is more challenging. For the example here, we will use an image from the web, because that is likely more common for students. It is just as easy to add an image from their own computers.

1) Use a search engine such as the one at http://search.creativecommons.org/# and find an image that you would like to put into your presentation.
2) Right-click on the image and choose
   a) Internet Explorer: Save Picture as...
   b) Firefox: Save Image as...
3) Save the image to your hard drive, memory stick, etc.
4) Copy the source (i.e. http://www.etc.com/image.jpg)
5) Click on the Insert button and then choose Image.

6) Click on Choose File
   Note: An image URL may change, so it's better to download it to your computer and then upload it to Google Docs in the manner explained here.

7) Choose the file that you just downloaded, then click OK.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
8) The image will be added to your slide and you can resize it or move it as you would like.
Creating a Form to Collect Student Responses

1) From the Google Docs homepage, click on New and then Form

2) The top part of the form has some basic info such as a title for the form and instructions that you may want to give. If you don’t want the form to be anonymous, click on the Automatically collect respondent's Google Apps username tickbox.

3) Begin entering your questions. You can choose from
   a) Text (short answer)
   b) Paragraph text (long answer)
   c) Multiple Choice (buttons – one choice)
   d) Checkbox (tick boxes – more than one choice)
   e) Choose from a list (drop down list – multiple choice – one choice)
   f) Rating scale (i.e. On a scale of 1 to 10)

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
4) You can make the question required so that they must answer it before they submit the complete form.

5) Click **Done** when you are finished working on the question.
6) Click on **Add Item** to add additional questions to your survey.

7) When you have added all of your questions, click the **Save** button at the top of the page.
8) At the bottom of the page, you can see the link to the page where the form is active.

9) Click on it and it will open in a new tab.

**Sharing the Survey with Students**

There are a variety of ways to have students access the form.

- Email
- Embed in a web page
- Hyperlink

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
The easiest way is to create a link to the page where the survey is located and post it on your Blog, Wiki, Website, Moodle, etc.

The Google Sites tutorial will demonstrate how to add a hyperlink to a web page.

**Viewing the Survey Results**
1) Return to the Google Docs Homepage
2) Find the Spreadsheet Form with the title you just made up for your survey.
3) Click on it.
4) You will be able to view your results and the form will be updated in real time as students complete the form.

5) Notice that the form gives a timestamp when the survey was completed, and lets you know which student completed the form.

**Student September Survey**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timestamp</td>
<td>Username</td>
<td>What is your favourite school subject?</td>
<td>What sports do you enjoy?</td>
</tr>
<tr>
<td>8/23/2009 20:25:55</td>
<td>abel32@collaborativ</td>
<td>Gym</td>
<td>Soccer</td>
</tr>
<tr>
<td>8/23/2009 20:26:16</td>
<td>abel32@collaborativ</td>
<td>Gym</td>
<td>Hockey</td>
</tr>
</tbody>
</table>

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
Creating a Graph in Google Spreadsheets

1) Create your spreadsheet.
2) Highlight the content you would like to graph and click Insert, and then Chart.

3) Choose the kind of graph you would like to create, and fill in the labels. The chart will be previewed at the bottom right of the dialogue box.

4) Click Save chart when finished.
5) Your chart will be added on top of your spreadsheet. You can move it around and/or resize it as you’d like.
6) You can also click on the heading to get more options such as moving it to its own sheet or saving it as an image that you could add to a document or presentation.
Collaborating on Sites

You can control many options in your website. Here we will look at how you can control who can see and edit your website.

1) Click on the More actions drop down menu and choose Share this site

2) In the Advanced Permissions section, you will want to change the settings to Anyone at ABEL Summer Institute may View this site. This prevents everyone from modifying your website.

3) You can now invite collaborators (grade partners, neighbours, trusted students, etc.) to your website by inviting collaborators, the same as you can do for other documents.

4) Click on Invite these people to make them collaborators.

5) They will now be able to edit and contribute to your web site.

6) Much like other Google Docs, you can look at the revision history of each page in your site. It is located under the More actions button.
Adding a Link on Your Site

1) Find the address of the site you would like to link to (in this case, I’ll use the link to the form that I created in the section on surveys and spreadsheets). Highlight and copy this address.

Tip: Use [CTRL] + [C] to copy and [CTRL] + [V] to paste.

2) Make sure you have clicked Edit Page on the page that you want to put the link on.
3) Type a title for the link (i.e. Click here for the September Student Survey)
4) Highlight your title and press the Link button.

5) In the Create Link dialogue box, click on Web Address to link to the web address (URL) you copied. Paste the link ([CTRL] + [V]) in the Link to this URL text box.

7) Click Open this link in a new window to make sure that your students can get back to the home page.
8) Press OK
Starting a Class Website Using Google Sites

1) From the ABEL Summer Institute Homepage (created using Google Sites), right-click on the Google Sites (Wikis) link and choose open link in New Tab.

2) Click on Create New Site

3) The first few options in the New Site dialogue box don’t really matter. You can give your site a name, address and put in a short description of your website.

4) The next few step is very important for the security of your website! When you choose your collaboration settings, you need to think about who you want
a) Everybody at your domain.
If you choose this, everyone that has an email address for your domain can see your site. This is fine if you are running Google Apps, just for your own classroom, but if you are running it for your whole school, and only want your students to be able to see the site, this is not the option for you. Also, if you are running a site that you only want teachers to be able to access, this is not for you.

b) Only people I specify can view this site.
Here, you select who can view the site. This gives you the most control.

c) Also let anyone in the world view this site (make it public).
This option can be turned off in Google Apps when you are an administrator so students and teachers will not see this option. Only people with an email address for the domain will be able to see the site. It has been left on for the ABEL Summer Institute to allow participants to see the site without having to log in.

For today’s purposes, choose Everybody at collaborativeschools.net.
5) Choose a theme for your wiki (it can be changed later if you don’t like it).
6) Click on Create Web to finish.
7) To edit the homepage, click on Edit Page.

8) An editing bar, similar to what you see in Documents and Presentations will appear at the top of your page.
9) Add text, graphics, etc. to make your homepage.
10) Save your work when you are finished.
11) Click Create page to add another page.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com
Firewalls

Some schools in the YRDSB prevent access to some parts of Google Apps through the “BESSY” firewall service.

Here are some tips to help you access Google Apps

Please talk to your administrator and let them know your plans before attempting the “work arounds” below.

1. Instead of using http:// use the secure https:// intro to the beginning of your URL.

   (i.e.  https://docs.google.com/a/collaborativeschools.net/ instead of http://docs.google.com/a/collaborativeschools.net/ instead)

2. Talk to your administrator about having the firewall rules changed to allow access to docs.google.com and sites.google.com.

3. Talk to your CRT to get some help about using Google Docs

This work is licenced under the Creative Commons Attribution-Non-Commercial-Share Alike 2.5 Canada License. To view a copy of this licence, visit http://creativecommons.org/licenses/by-nc-sa/2.5/ca/ or send a letter to Creative Commons, 171 Second Street, Suite 300, San Francisco, California 94105, USA.

Created by Scott Monahan for ABEL Summer Institute 2009
monahan.scott@gmail.com